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1Y0-A06 Implementing Citrix Provisioning Server 5.0
#Planning a Citrix Provisioning Server 5.0 Implementation

1. During the Provisioning Server boot process, _? assigns IP addresses to target devices,
_?_enables target devices to boot from a network interface and _?_ delivers boot
information to target devices.

a. the Citrix License Server; SOAP; the Stream Service

b. the data store; UDP; BOOTP

c. DHCP; PXE; TFTP

d. the Master Target Device; the vDisk; the pool
Answer: c.
Explanation: During the Provisioning Server boot process, DHCP (Dynamic Host
Configuration Protocol) assigns IP addresses to target devices, PXE (Pre-Execution
Environment) enables target devices to boot from a network interface and TFTP (Trivial
File Transfer Protocol) delivers boot information to target devices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 42

2. Scenario: An administrator has started deploying target devices in a Provisioning Server
5.0 implementation with DHCP and PXE configured to boot the target devices. Although
using a network speed of 1GB, the target devices appear to hang during the boot
process. This didn't happen during testing. The test environment is also a 1GB network,
but did not exactly duplicate the same network configurations, particularly the use of
network switches. Which of the following configurations will most likely fix this
problem?

a. Disable auto-negotiation on the Provisioning Server NICs

b. Disable loop detection on the ports to which the target devices are connected

c. Configure the 'License timeout' setting for a longer time in Server Properties

d. Configure the 'l/O burst size' for a larger 10 burst in Server Properties
Answer: b.
Explanation: Managed network switches usually offer loop detection software. This
software turns off a port until the switch is certain the new connection does not create a
loop in the network. The delay prevents the target device from PXE booting. If this is the
case, the target device login will fail or the target device will appear to hang either
during the boot or shutdown process. To avoid this problem, disable loop detection on
the ports to which the target devices are connected.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 171, 172

3. According to best practices, an administrator should _?_prior to installing Provisioning
Server.
a. setup HA and load balancing features
b. open up all of the correct ports on the firewall
c. setup a Master Target Device
d. assign a static IP address to the server
Answer: d.
Explanation: According to best practices, an administrator should assign a static IP
address to the server prior to installing Provisioning Server.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 81
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4. Which of the following components is responsible for determining which vDisk to

stream to a target device?

a. Provisioning Server database

b. Master Target Device

c. Citrix License Server

d. Provisioning Server
Answer: d.
Explanation: The Provisioning Server is responsible for providing target device
information, including determining which vDisk to stream to a target device.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 40

5. What are three component settings that the Provisioning Server database stores?
a. vDisk
b. Provisioning Server
c. target device
d. licensing
Answer: a.b.c.
Explanation: The Provisioning Server database stores all Provisioning Server, vDisk,
target device and system configuration settings that exists within a server farm.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

6. A _?_isafile that contains an image of a server workload, which is streamed to a target
device via Provisioning Server.

a. vDisk

b. template

c. bootstrap

d. PXE
Answer: a.

Explanation: A template is a file that contains an image of a server workload.
Provisioning Server streams the image to target devices. vDisks are housed in a store,
which can be located either locally on a Provisioning Server or on a shared storage
device.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

7. A _? isused to create a vDisk that will be shared by multiple users.

a. target device

b. Master Target Device

c. template

d. stream
Answer: b.
Explanation: A Master Target Device is used to create and test a golden image and
represents the pristine state of a system, including all operating system and application
updates and configurations. The Master Target Device is used to create a vDisk that will
be shared by multiple users.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

8. A physical storage location for vDisks is calleda _?_.
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a. pool
b. stream
c. store
d. depot
Answer: c.

Explanation: A store (or disk store) is the logical name given to a physical storage
location for vDisks. A store could be placed on a local drive on a Provisioning Server, a
SAN, a CIFS share, a NAS or a UNC path. A store can be used for an entire farm, a site or
a server.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

9. What s a collection of all the vDisks available to a site called?

a. stream
b. store
c. depot
d. pool
Answer: d.

Explanation: A vDisk pool is a collection of all the vDisks available to a site.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

10. How many vDisk pools can a site contain?

a. one
b. two
c. one for each server
d. nolimit

Answer: a.

Explanation: A site can contain only one vDisk pool.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

11. A _?_ is any desktop or server system that receives a streamed operating system and
applications from a vDisk.
a. Master Target Device
b. target device

c. client
d. receiver
Answer: b.

Explanation: A target device is any desktop or server system that receives a streamed
operating system and applications from a vDisk. Each target device continues to have its
own identity on the network and within the existing network directory services.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 41

12. An administrator can use a boot device management (BDM) utility to retrieve boot
information from: (Choose 3)

a. USB
b. TFTP
c. CD-ROM

d. hard drive partition
Answer: a.c.d.
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Explanation: As an alternative to using DHCP, PXE and TFTP, IP and boot information for
a target device can be provided by a boot device management (BDM) utility. The BDM
utility enables target devices to retrieve boot information from USB, CD-ROM (ISO file)
or a hard drive partition.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 43

13. Scenario: A Provisioning Server implementation is using a boot device management
utility to retrieve the boot information for target devices. Which of the following
locations is the boot information being retrieved from?

a. DHCP Service
b. BootP Service

c. ISO file
d. TFTP Service
Answer: c.

Explanation: As an alternative to using DHCP, PXE and TFTP, IP and boot information for
a target device can be provided by a boot device management (BDM) utility. The BDM
utility enables target devices to retrieve boot information from USB, CD-ROM (ISO file)
or a hard drive partition.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 43

14. Scenario: A stand-alone DHCP server with no PXE Service is being used to obtain IP and
boot information for the target devices in the Provisioning Server environment. Which
of the following DHCP options are configured in this scenario?

a. 60,66

b. 66,67

c. 60

d. None
Answer: b.

Explanation: When using a stand-alone DHCP server with no PXE Service in a
Provisioning Server environment, DHCP options 66 and 67 must be manually configured.
Option 66 identifies the FQDN or IP address of the TFTP Service. Option 67 identifies the
name of the bootstrap file (the default is ARDBP32.BIN).

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 50 - 53

15. Scenario: An administrator is implementing a Provisioning Server installation and does
not have access to DHCP configuration. The administrator chooses to set up a proxy
DHCP server to host the PXE Service. What ports will be used in this implementation?

(Choose 2)
a. 67
b. 68
c. 69
d. 4011

Answer: a.d.

Explanation: If an administrator does not have access to the DHCP configuration, they
may choose to set up a proxy DHCP server that hosts the PXE Service. The DHCP Service
uses port 67 to send the target device its IP address and the PXE Service uses port 4011
to send the IP address of the TFTP server and name of the bootstrap file to the target
device.
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Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 50 - 56

16. Scenario: An administrator is implementing a Provisioning Server installation and does
not have access to DHCP configuration. The administrator chooses to set up a proxy
DHCP server that hosts the boot services. What port(s) will be configured?

a. 67,4011

b. 4011

c. 68,4011

d. 67

e. 68
Answer: d.

Explanation: If an administrator does not have access to the DHCP configuration, they
may choose to set up a proxy DHCP server that hosts the boot services. Port 67 will be
used by the DHCP Service to send the target device its IP address and also by the proxy
DHCP Service to send the IP address of the TFTP Service and the name of the bootstrap
file to the target device.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 50 - 57

17. To allow DHCP broadcasts through a Cisco router, which of the following configurations

need to be made?

a. Runthe IP HELPER command

b. Disable spanning tree

c. Enable spanning tree portfast mode

d. Configure DHCP options 66 and 67
Answer: a.
Explanation: Routers block DHCP broadcasts, which would prevent communications
between a target device and Provisioning Server. To alleviate the situation, configure
the router to allow broadcasts using the DHCP relay agent using the Cisco router
command IP HELPER.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 53

18. Scenario: A company is planning to install a large Provisioning Server 5.0
implementation that will span three major US cities: New York, Chicago and Los Angeles.
You are asked just from this information how many farms you think they will need to
implement. What is your best answer at this point?

a. onefarm

b. two farms

c. threefarms

d. Provisioning Server doesn't use farms
Answer: a.
Explanation: Large enterprises with offices around the world should consider creating a
farm for each major business region to avoid latency. For example, if target devices are
located in North America, Europe and Central America, consider creating three farms.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 58

19. Scenario: A company is planning to install a large Provisioning Server 5.0
implementation that will span three business regions: North America, Europe and
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Central America. You are asked just from this information how many farms you think
they will need to implement. What is your best answer at this point?

a. onefarm

b. two farms

c. three farms

d. Provisioning Server doesn't use farms
Answer: c.
Explanation: Large enterprises with offices around the world should consider creating a
farm for each major business region to avoid latency. For example, if target devices are
located in North America, Europe and Central America, consider creating three farms.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 58

20. Scenario: A company is planning to install a large Provisioning Server 5.0
implementation that will include 3 farms, 15 sites, 30 Provisioning Servers, 30 device
collections and 1,500 target devices. How many databases are needed for this
environment?

a. one
b. three
c. fifteen
d. thirty

Answer: b.

Explanation: One Provisioning Server database is associated with each farm.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

21. Scenario: A company is planning to install a Provisioning Server 5.0 implementation that
will include 1 farm, 3 sites, 8 Provisioning Servers, 4 device collections and 400 target
devices. How many databases are needed for this environment?

a. one
b. three
c. four
d. eight

Answer: a.

Explanation: One Provisioning Server database is associated with each farm.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

22. All Provisioning Server components that access the database must run in the context of
a(n) _?_ account.
a. administrator
b. Network Service, specified user or local

c. user
d. logged-in user
Answer: c.

Explanation: All Provisioning Server components, including services that access the
database must run in the context of a user account.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

23. User tools such as the Configuration Wizard run in the context of a(n) _?_.
a. administrator
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b. Network Service, specified user or local

c. user
d. logged-in user
Answer: d.

Explanation: User tools such as the Configuration Wizard run in the context of a logged-
in user.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

Services used for Provisioning Server can be runas _?_.

a. administrator

b. Network Service account, specified user account or local user account

c. useraccount

d. logged-in user
Answer: b.
Explanation: Services, such as the Stream Service and SOAP Service, can be run as the
Network Service account, specified user account or local user account. The account
must have the following minimum system privileges: Run as service, registry read
access, read/write access to C:\Program Files\Citrix\Provisioning Server and read/write
access to any vDisk location.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

The account that runs the Stream Service must have which of the following privileges?
(Choose 4)
Registry read access
Read/Write access to C:\Program Files\Citrix\Provisioning Server
Full control access to user profiles
Farm administrator rights
Read/Write access to any vDisk location
f. Datawriter and Datareader access to the database
Answer: a.b.e.f.
Explanation: The account that runs the Stream Service must have registry read access,
Read/Write access to C:\Program Files\Citrix\Provisioning Server, Read/Write access to
any vDisk location and Datawrite/Datareader access to the database.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

oo T

The credentials of the _?_are used to create the database during initial configuration.
a. administrator
b. Network Service account, specified user account or local user account
C. useraccount
d. logged-in user
Answer: d.
Explanation: The credentials of the currently logged-in user are used to create the
database during initial configuration because the Configuration Wizard runs in the
context of that user account. The user must be a member of the db_datawriter group
and have sufficient privileges to create a database.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59
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27. During initial configuration of the database, to what group must the logged-in user
belong?
a. Power Users
b. Domain Admins
c. db_datawriter
d. db_owner
Answer: c.
Explanation: During initial configuration of the database the logged-in user must belong
to the db_datawriter group and have sufficient privileges to create a database.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

28. Which of the following are true statements about administrative roles? (Choose 3)
a. Administrative roles are created through the Configuration Wizard
b. Administrative groups must first be created in Active Directory before roles can
be configured
c. Groups are managed at the farm level through the Provisioning Server Console
d. Administrators may have multiple roles if they belong to multiple groups
Answer: b.c.d.
Explanation: Administrative groups must first be created in Active Directory before roles
can be configured. Groups are managed at the farm level through the Provisioning
Server Console's Farm Properties dialog. Administrators may have multiple roles if they
belong to multiple groups.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 29

29. Scenario: The Help Desk personnel are going to be responsible for a few of the less
critical tasks in the Provisioning Server farm, including: Viewing vDisk and target device
properties, booting and shutting down target devices and sending messages to target
devices. Which of the following administrative roles should be given to the Help Desk
personnel?

a. Site Administrators

b. Device Operators

c. Farm Administrators

d. Device Administrators
Answer: b.
Explanation: Device Operators can view the properties of a vDisk assigned to a target
device, view target device properties, boot target devices, shut down target devices and
send messages to target devices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 65, 66

30. Scenario: A Junior Systems Administrator that recently joined the IT group needs to be
assigned privileges for the Provisioning Server farm. The administrator will need
permissions to assign and unassign vDisks to target devices, modify properties of target
devices and manage several aspects of device collections. Which of the following
administrative roles should be given to the Junior Systems Administrator?

a. Site Administrators

b. Device Operators

c. Farm Administrators
d. Device Administrators
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Answer: d.

Explanation: Device Administrators can perform the same tasks as Device Operators,
with the added permissions to assign and unassign vDisks to target devices, modify
properties of target devices and device collections, modify device templates for device
collections, move target devices from one device collection to another within a site,
remove target devices from device collections and delete target devices from
collections.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 66

31. Which of the following tasks can a Site Administrator perform? (Choose 2)
a. Manage all objects within a site
b. Manage all objects within a farm
c. Manage Device Administrator and Device Operator memberships
d. Manage role memberships throughout the farm
Answer: a.c.
Explanation: Site Administrators can perform the same tasks as a Device Administrator
and also manage all objects within a site and manage Device Administrator and Device
Operator memberships.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 66

32. Which administrative role can manage role memberships throughout the farm?
a. Site Administrators
b. Device Operators
c. Farm Administrators
d. Device Administrators
Answer: c.
Explanation: A Farm Administrator can perform the same tasks as a Site Administrator
and also manage all objects within a farm and manage role memberships throughout
the farm.
Source: CPV-200-11 Implementing Citrix Provisioning Server 5.0, Page 66

33. _? canrepresent any logical grouping, typically including a building or geographic

location.
a. Sites
b. Farms
c. Device collections
d. Stores
Answer: a.

Explanation: Sites can represent any logical grouping, but typically represent a physical
site, building or geographic location.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

34. A _? isthe logical name for the physical location of the vDisk folder that can exist on
either a local server or shared storage.

a. site

b. store

c. farm

d. device collection
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Answer: b.

Explanation: A store is the logical name for the physical location of the vDisk folder that
can exist on either a local server or shared storage.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 60

35. Scenario: A school district with 18 schools uses 36 production XenApp servers to deliver
several applications to target devices throughout the district. They also have 10 test
servers to test new applications and updates on. Of the 18 schools, 13 are K-5 schools, 3
are middle schools and 2 are high schools. Each type of school (K-5, middle, or high), is
on a separate subnet. Which of the following implementations makes the most sense
for this scenario?

a. Two farms, one for production and one for testing; three sites, one for each
type of school; three device collections, one for each subnet
b. Four farms, one for each type of school and one for testing; 18 sites, one for
each school; 18 device collections, one for each school
c. One farm for the whole district; 18 sites, one for each school; three device
collections, one for each subnet
d. One farm for the whole district; one site for the whole district; one device
collection for the whole district
Answer: c.
Explanation: Best practices states to install one farm for each major business region, one
site for each physical site, building or geographic location and one device collection for
each logical grouping, which can include physical location, subnet range or organization
name. Of the choices given, one farm, 18 sites and three device collections make the
most sense according to best practices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 58 - 64

36. Best practices states that one site should be created for each _? .
a. major business region
b. geographic location
c. logical grouping
d. subnetrange
Answer: b.
Explanation: Best practices states that one site should be created for each geographic
location, physical site or building.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 59

37. Best practices states that one farm should be created for each _?_.
a. major business region
b. geographic location
c. logical grouping
d. subnetrange
Answer: a.
Explanation: Best practices states that one farm should be created for each major
business region.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 58

38. Best practices states that one device collection should be created for each _? .
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major business region
geographic location
logical grouping
d. physical site
Answer: c.
Explanation: Best practices states that one device collection should be created for each
logical grouping, such as a subnet range or organization name.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 64

oo

_?_allow administrators to perform the same tasks to multiple target devices
simultaneously.

a. Sites
b. Farms
c. Device collections
d. Stores
Answer: c.

Explanation: Device collections allow administrators to perform the same tasks to
multiple target devices simultaneously.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 64

A _?_ configuration provides failover protection and ensures the connection between a
target device and a vDisk is maintained in the event that a Provisioning Server fails.

a. RAIDS

b. load balancing

c. bonded NIC
d. high availability
Answer: d.

Explanation: A high availability (HA) configuration provides failover protection and
ensures the connection between a target device and a vDisk is maintained in the event
that a Provisioning Server fails.

Source: CPV-200-11 Implementing Citrix Provisioning Server 5.0, Page 66

Target devices use _?_to request and receive the bootstrap file.

a. TFTP
b. DHCP
c. PXE
d. BootP
Answer: a.

Explanation: Target devices use TFTP (Trivial File Transfer Protocol) to request and
receive the bootstrap file.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 45

Using the Configuration Wizard, enable the _?_Service and provide up to four
Provisioning Servers in the _? .

a. SOAP; device template

b. TFTP; bootstrap file

c. PXE; Master Target Device

d. Stream; DHCP options
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Answer: b.

Explanation: The TFTP Service is not enabled by default, so must be enabled in the
Configuration Wizard. After enabling the TFTP Service, specify the location of the
bootstrap file, which contains the names of up to four Provisioning Servers.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 93

#Configuring the Initial Setup

43.

44.

45.

An administrator must be sure that port _?_is open between a Provisioning Server and
License Server in the case that a firewall sits between them.

a. 443

b. 3389

c. 27000

d. 389
Answer: c.

Explanation: The License Server communicates with Provisioning Servers over port
27000.
Source: Citrix Knowledge Center, Article CTX117874

If needed, be sure to open port _?_on a firewall sitting between the Soap Service and
Provisioning Server Console.

a. 27000
b. 3389
c. 8000
d. 4011
Answer: c.

Explanation: The Soap Service uses port 8000 by default. So if there is a firewall sitting
between the Soap Service and any Provisioning Server Consoles, be sure that port 8000
is opened on the firewall.

Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 39

An administrator should consider which of the following network configuration factors
before implementing Provisioning Server? (Choose 3)
a. Managed switch ports connected to target devices should have portfast mode
disabled
b. Any firewalls between the Provisioning Server and target devices should be
configured to accept Provisioning Server packets
c. Ifthe DHCP server and target devices are on separate subnets, the router
interface directly connected to the target device subnet must be configured
with the IP-helper command
d. Managed switch ports connected to target devices should have spanning tree
disabled
Answer: b.c.d.
Explanation: Managed switch ports connected to target devices should either have
spanning tree disabled or portfast mode enabled if spanning tree is enabled. Any
firewalls between the Provisioning Server and target devices should be configured to
accept Provisioning Server packets. If the DHCP server and target devices are on
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separate subnets, the router interface directly connected to the target device subnet
must be configured with the IP-helper command.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 180

Scenario: An administrator is planning a Provisioning Server implementation where a
firewall will sit between the DHCP server and the target devices. DHCP and Proxy DHCP
will be hosted on the same system. Which of the following ports need to be open on the
firewall to allow DHCP to properly communicate with the target devices? (Choose 2)

a. 67

b. 443

c. 3389

d. 4011
Answer: a.d.

Explanation: When setting up a Provision Server implementation, if DHCP Proxy and
DHCP will be hosted on the same server, they will use ports 67 (DHCP) and 4011 (DHCP
Proxy since port 67 is already taken). If there is a firewall between the DHCP server and
the target devices, these ports need to be open.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 52

Scenario: An administrator is planning a Provisioning Server implementation where a
firewall will sit between DHCP and the target devices. DHCP and Proxy DHCP will be
hosted on the separate servers. Which of the following ports need to be open on the
firewall to allow DHCP to properly communicate with the target devices?

a. 67and 4011

b. 67 and 443

c. 67

d. 443

e. 4011
Answer: c.

Explanation: When setting up a Provision Server implementation, if DHCP Proxy and
DHCP will be hosted on separate servers, they will both use port 67. If there is a firewall
between the servers and the target devices, this port needs to be open.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 52

Scenario: An administrator is planning a Provisioning Server implementation where a
firewall will sit between the DHCP server and the target devices. A standalone DHCP
server with no PXE Service will be used. Which of the following ports need to be open
on the firewall to allow DHCP to properly communicate with the target devices?

a. 67

b. 443

c. 3389

d. 4011
Answer: a.

Explanation: When setting up a Provision Server implementation, if a standalone DHCP
server with no PXE Service will be used, it will use port 67. If there is a firewall between
the server and the target devices, this port needs to be open.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 52
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Scenario: A Provisioning Server implementation is due to be upgraded from version 4.5
to 5.0. The team assigned to this project is going to perform an in-place upgrade. Which
of the following steps will the team use to complete the upgrade? (Choose 4)

a. Install product software

b. Migrate the database

c. Convert vDisks to VHD format

d. Upgrade the vDisk

e. Upgrade product software
Answer: b.c.d.e.
Explanation: When performing an in-place upgrade from any 4.x version to 5.0, the
steps to upgrade are: 1. Upgrade the product software. 2. Migrate the database. 3.
Convert vDisks to VHD format. 4. Upgrade the vDisk. If it was a rolling upgrade, step 1
would have been to install the product software.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Pages 55 - 62

When upgrading from Provisioning Server 4.x to 5.0, if the original hard drive that was
used to create the vDisks is no longer available, the administrator should use the _?
method to upgrade the vDisks.

a. rolling upgrade

b. in-place upgrade

c. manual upgrade

d. dynamic upgrade
Answer: c.
Explanation: When upgrading from Provisioning Server 4.x to 5.0, if using a new hard
drive because the original hard drive used to create the vDisks is no longer available, the
administrator should use the manual upgrade method to upgrade the vDisks.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 83

Use ?_ to convert version 4.x vDisks to the new virtual hard disk format.
a. UpgradeAgent.exe
b. vhdConverter.exe
c. the MCLI Importdatabase command
d. UpgradeManager.exe
Answer: b.
Explanation: When upgrading from Provisioning Server 4.x to 5.0, use vhdConverter.exe
to convert version 4.x vDisks to VHD format.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 55

Scenario: The IT department is planning to perform a rolling upgrade of the Provisioning
Server environment from version 4.1 to 5.0. Which of the following steps should the
project team take to complete the upgrade? (Choose 4)

a. Migrate the database

b. Upgrade product software

c. Convert vDisks to VHD format

d. Install product software

e. Upgrade the vDisk
Answer: a.c.d.e.
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Explanation: When performing a rolling upgrade from any 4.x version to 5.0, the steps to
upgrade are: 1. Install the product software. 2. Migrate the database. 3. Convert vDisks
to VHD format. 4. Upgrade the vDisk. If it was an in-place upgrade, step 1 would have
been to upgrade the product software.

Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Pages 55 - 62

When upgrading a version 5.0 Provisioning Server farm to 5.0.x, which of the following
steps is required before connecting to the upgraded database?

a. Login asroot

b. All servers in the farm must be upgraded

c. Convert the vDisks to VHD format

d. Change the target device to Standard Image mode
Answer: b.
Explanation: When upgrading a 5.0 Provisioning Server farm, all servers in that farm
must be upgraded before connecting to the upgraded database. A 5.0 Provisioning
Server is not compatible with a 5.0.x database.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 62

Scenario: A Provisioning Server implementation is due to be upgraded from version 5.0
to 5.0.1. Which of the following steps should the upgrade team use to complete the
upgrade? (Choose 3)

a. Migrate the database

b. Upgrade the Provisioning Servers

c. Convert vDisks to VHD format

d. Upgrade the vDisk

e. Backup the data
Answer: b.d.e.
Explanation: When performing an upgrade from version 5.0 to 5.0.x, the steps to
upgrade are: 1. Backup the data. 2. Upgrade the Provisioning Servers. 3. Upgrade the
vDisk.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Pages 62 - 64

When upgrading a vDisk, the administrator should boot the vDisk into _? mode.

a. Standard Image

b. Different Disk Image

c. Private Image

d. Public Image
Answer: c.
Explanation: When upgrading a vDisk, assign the VHD formatted vDisk to the target
device that will be used to upgrade, change the target device vDisk to Private Image
mode and PXE boot the target device from the vDisk.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 63

If the location of the database changes after the initial configuration, which of the
following steps should an administrator take? (Choose 2)

a. Re-join the existing farm and enter the new database location

b. Run the Configuration Wizard

c. Open the Farm Properties
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d. Enter the new database location in Farm Properties
Answer: a.b.
Explanation: If the location of the database or the name of the database instance
changes, run the Configuration Wizard, re-join the existing farm and enter the new
information.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 89

After completing Provisioning Server software installation on a new server, what is the
next step?

a. Integrate Active Directory

b. Run the Configuration Wizard

c. Configure role-based administration

d. Test the server
Answer: b.
Explanation: After installing the Provisioning Server software, the Configuration Wizard
is run on the server to configure, among other things, DHCP, PXE, farm, database,
service user account, License Server, network card and TFTP Service settings.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 85

When creating the Master Target Device, the configuration includes: (Choose 3)

a. Configure the target device BIOS to PXE boot

b. Set the target device properties to boot from hard disk

c. Setthe vDisk to Standard Image mode

d. Verify communications between the target device and Provisioning Server
Answer: a.b.d.
Explanation: When creating the Master Target Device: Set the vDisk to Private Image
mode (NOT Standard Image mode), configure the target device BIOS to PXE boot, set
the target device properties to boot from hard disk and verify communications between
the target device and Provisioning Server.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 173

When creating the Master Target Device, set the boot methodas _? .
a. vDisk

b. floppy disk

c. CD/DVD

d. hard disk
Answer: d.

Explanation: When creating the Master Target Device, set the target device properties
to boot from hard disk.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 173

Scenario: An administrator created a vDisk from a Master Target Device. Now the
administrator is preparing to create a target device to use the vDisk. When creating the
target device the administrator should set the boot methodto _? .

a. vDisk

b. CDROM
c. PXE

d. hard disk
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Answer: a.
Explanation: When creating a target device, vDisk should be chosen as the boot method.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 174, 175

61. Which of the following steps must be taken on the Master Target Device before

installing the target device software? (Choose 3)

a. Prepare the Master Target Device's hard disk

b. Configure the Master Target Device's BIOS

c. Configure the network adapter BIOS

d. Build the vDisk image
Answer: a.b.c.
Explanation: The steps, in order, to build a Master Target Device are: 1. Prepare the
Master Target Device's hard disk. 2. Configure the Master Target Device's BIOS. 3.
Configure the network adapter BIOS. 4. Install the Master Target Device software.
Source: Citrix Provisioning Server 5.0 Installation and Configuration Guide, Page 44

62. When preparing to build the Master Target Device, which of the following tasks must be
accomplished? (Choose 5)
Install all of the drivers
Install the target device software
Place the operating system in Private Image mode
Apply all necessary service packs
Install all necessary applications
f. Install the operating system
Answer: a.b.d.e.f.
Explanation: To prepare to build the Master Target Device, install the operating system,
install all of the drivers, apply all necessary service packs, install the target device
software and install all necessary applications. When creating the Master Target Device,
you would set the vDisk to Private Image mode, but there is no such mode for the
operating system, as listed in choice f.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 173

© oo oo

63. If creating a new farm during Provisioning Server configuration, which of the following

items of information must be provided in the Configuration Wizard? (Choose 4)

a. Database server and instance name

b. Database name

c. DHCP server name, port number and subnet range

d. Farm, site and collection names

e. Security method and administrator group
Answer: a.b.d.e.
Explanation: Using the Configuration Wizard to configure a new Provisioning Server
farm, you will need to enter the database server and instance name, the database, farm,
site and collection names and the security method and administrator group.
Source: CPV-200-11 Implementing Citrix Provisioning Server 5.0, Pages 95, 96

64. Scenario: An administrator has created and allocated space for a vDisk file on a

Provisioning Server. Which of the following steps must the administrator perform to
complete the vDisk creation process? (Choose 3)
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Mount the vDisk
Format the vDisk
Dismount the vDisk

d. Clone the vDisk
Answer: a.b.c.
Explanation: After creating a vDisk file and allocating space for it on a Provisioning
Server, the next steps are to mount the vDisk file to a disk drive on the Provisioning
Server, format the vDisk file so an image can be written to it and dismount the vDisk file
from the disk drive so that a target device can connect to it.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 157

oo

65. The information an administrator needs to create a new vDisk file includes the
following: (Choose 3)

a. Site

b. Collection
c. Server

d. Domain
e. Format

Answer: a.c.e.

Explanation: To create a new vDisk file in the Provisioning Server Console, right-click a
store or vDisk pool and click Create vDisk. Select the site that will contain the vDisk.
Select the server to use to create the vDisk. Type a filename and optional description.
Type the size in MB of the vDisk. Select either a fixed or dynamic format for the vDisk.
Click Create vDisk.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 158

66. To create a new vDisk, an administrator can right-click on eithera ? or _?_ and select
Create vDisk. (Choose 2)
a. vDisk pool
b. device collection

c. site
d. store
Answer: a.d.

Explanation: To create a new vDisk an administrator will right-click on either a vDisk
pool or a store.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 158

67. If joining an existing farm, but creating a new site during Provisioning Server
configuration, which of the following items of information must be provided in the
Configuration Wizard? (Choose 2)

a. Site name

b. Database name

c. DHCP server name, port number and subnet range

d. Collection name

e. Security method and administrator group
Answer: a.b.
Explanation: When joining an existing farm, but creating a new site during Provisioning
Server configuration, the administrator must provide the site name and collection name.
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Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 88

Scenario: An administrator must create a vDisk file that will be used for vDisks which can
grow at their own pace as users install applications and add data. When creating the
vDisk file, the administrator should choose which VHD format?

a. Private

b. Fixed

c. Dynamic

d. Public
Answer: c.

Explanation: A dynamic vDisk does not allocate the entire disk space when the file is
created. Instead, the administrator sets the maximum vDisk size and the vDisk file grows
as the size of the image grows. Dynamic disks make planning easier, especially for
Private Image mode vDisks, which can grow at their own pace as users install
applications and add data.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 157

Scenario: An administrator knows exactly how much space he needs to allocate for a
vDisk file that will be used for users that cannot install their own applications or save
data to the image. When creating the vDisk file, the administrator should choose which
VHD format?

a. Private
b. Public
c. Dynamic
d. Fixed
Answer: d.

Explanation: A fixed vDisk file allocates all of the disk space when the file is created. This
allotted space must be large enough to hold the operating system and any required
applications. Administrators should allow enough space on the vDisk for any
applications that will be installed at a later time.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 157

Which of the following tasks must the administrator perform before being able to view
and edit the contents of a vDisk image file?

a. Mount the vDisk

b. Dismount the vDisk

c. Setthe vDisk to Private Image mode

d. Set the vDisk to Standard Image mode
Answer: a.
Explanation: Administrators can view and edit the contents of a vDisk image file after
mounting the vDisk. A vDisk can be mounted regardless of which image mode is
configured.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 160

An administrator must _?_ an imaged vDisk file before a target device can connect to it.

a. mount
b. dismount
c. format
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d. eject
Answer: b.
Explanation: After formatting and imaging a vDisk file, the file must be dismounted from
the Provisioning Server before a target device can connect to it.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 162, 163

Before a Master Target Device image can be added to a vDisk file, an administrator must
_?_ the vDisk after it has been mounted to a local drive on the Provisioning Server.

a. eject
b. open
c. format
d. share
Answer: c.

Explanation: In order to add a Master Target Device image to a vDisk file, an
administrator must format the vDisk after it has been mounted to a local drive on the
Provisioning Server.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 162

A vDisk file must be _? before it can be formatted and imaged.

a. ejected from a local drive on the Provisioning Server

b. shared on a local drive on the Provisioning Server

c. dismounted from a local drive on the Provisioning Server

d. mounted to a local drive on the Provisioning Server
Answer: d.
Explanation: In order to add a Master Target Device image to a vDisk file, an
administrator must format the vDisk after it has been mounted to a local drive on the
Provisioning Server.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 162

Scenario: A vDisk file was just created by an administrator. The administrator now wants
to mount and format the vDisk file. Which of the following steps should the
administrator take? (Choose 2)

a. Inthe Provisioning Server Console, right-click the vDisk and select Mount

b. Inthe Provisioning Server Console, right-click the vDisk and select Format

c. In My Computer, right-click the vDisk and select Mount

d. In My Computer, right-click the vDisk and select Format
Answer: a.d.
Explanation: To mount and format a vDisk file, right-click on the vDisk in the
Provisioning Server Console and select mount. Open My Computer and right-click on the
vDisk (which will show up as a removable drive with a letter, such as E:) and select
format.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 163

Which of the following steps are taken to format a mounted vDisk file? (Choose 2)
a. With My Computer opened up in Windows, right-click on the vDisk in the
Provisioning Server Console and select Format
b. With the Provisioning Server Console running, open My Computer in Windows,
right-click on the removable disk and select Format
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c. Choose the operating system

d. Choose the file system
Answer: b.d.
Explanation: To format a mounted vDisk, open My Computer, right-click on the
removable disk which represents the vDisk (for example, the drive letter E:) and select
Format. The Provisioning Server Console must be running in order for the operating
system to recognize the vDisk as removable. Accept the default capacity setting. Choose
a file system type and accept the default allocation unit size. Type a label in the 'Volume
label' field to identify the vDisk mapped drive. Click Start. Click OK in the warning dialog
box. Click OK when formatting is complete and click Close to close the Format vDisk
window.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 163

76. It is recommended that the Master Target Device have the following hardware: (Choose
3)
1GHz processor
256MB RAM
1GB Ethernet
d. PXEv0.99 or later network adapter
Answer: a.c.d.
Explanation: The recommended hardware for the Master Target Device is 1GHz
processor, 1GB RAM (256MB is the minimum, but not recommended), 1GB PXE v0.99 or
later network work adapter.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 175, 176

0T o

77. Scenario: An administrator needs to make changes to an existing site. Which step should
the administrator take first to make the changes?
a. Right-click the site in the Provisioning Server Console and select Properties
b. Right-click the site in the Provisioning Server Console and select Configuration
Wizard
c. Run setup and make the changes in the Configuration Wizard
d. Right-click the Sites node in the Provisioning Server Console and select
Configure Site
Answer: a.
Explanation: To make changes in an existing site, right-click the site in the Provisioning
Server Console and select Properties. The Site Properties dialog will open and changes
can be made on it.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 111

78. Scenario: An administrator needs to create a new site in a farm. Which step should the
administrator take to start the creation process?
a. Right-click any site in the Provisioning Server Console and select New Site
b. Right-click the Sites node in the Provisioning Server Console and select Create
Site
c. Run setup and create a new site in the Configuration Wizard
d. Right-click the Site node in the Provisioning Server Console and select
Configuration Wizard
Answer: b.
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Explanation: To create a new site in the Provisioning Server Console, right-click the Sites
node and click Create Site. Type the name of the site in the Name field and make any
additional configuration changes. Click OK.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 115

To change the name and description of a site, open the Site Properties and access the
_?_ tab.

a. Options
b. General
c. Name and Description
d. Security
Answer: b.

Explanation: There are three tabs in the Site Properties dialog: General, Security and
Options. The name and description are viewed and configured on the General tab.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 111, 112

To give a group Site Administrator privileges for a particular site, open the Site
Properties and access the _?_tab.

a. Options

b. General

¢. Administrator

d. Security
Answer: d.

Explanation: There are three tabs in the Site Properties dialog: General, Security and
Options. Add groups to the Security tab to give them Site Administrator privileges.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 111, 113

In which tab of the Site Properties dialog would you select the device collection for the
site?

a. Security

b. General

c. Options

d. Device Collection
Answer: c.

Explanation: There are three tabs in the Site Properties dialog: General, Security and
Options. Select the device collection for the site in the Options tab of the Site
Properties.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 111, 114

Scenario: An administrator needs to add a new server to an existing site. Which of the
following steps should the administrator take to do so? (Choose 3)

a. Run the Configuration Wizard on the server

b. Install Provisioning Server on the server

c. Choose to join the existing farm and site

d. Right-click on the site in the Provisioning Server Console and choose Add Server
Answer: a.b.c.
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Explanation: To add a new server to an existing site, install Provisioning Server on the
new server, run the Configuration Wizard on the new server and choose to join the
existing farm and site.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 116

Scenario: An administrator needs to move a server from one site to another. Which of
the following steps should the administrator take to do so? (Choose 2)

a. Run the Configuration Wizard on the server

b. Install Provisioning Server on the server

c. Choose to join the existing farm and specify a new site

d. Right-click on the site in the Provisioning Server Console and choose Add Server
Answer: a.c.
Explanation: To move a server from one site to another, run the Configuration Wizard
on the server, choose to join the existing farm and specify a new site.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 117

_?_or_? stores must use UNC paths to access the storage location. (Choose 2)
a. Distributed
b. Farm
c. Private
d. Site
Answer: b.d.

Explanation: Farm or site stores must use UNC paths to access the storage location,
while private or distributed stores can use a path to a local hard drive.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 118

The disk storing vDisk images should be formatted with which file system?
a. FAT32

b. EXT2

c. EXT3

d. NTFS
Answer: d.

Explanation: If the disk storing the vDisk images is formatted with NTFS, the limit is
approximately 2TB, thus making it the best option for storing vDisks. Using FAT it is only
4GB. The vDisk images cannot be stored on the Linux file systems, EXT2 or EXT3.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 85

The _?_file system allows a maximum vDisk size of 2TB.

a. FAT
b. NTFS
c. EXT2
d. EXT3
Answer: b.

Explanation: The NTFS file system allows a maximum vDisk size of 2TB, making it the file
system to use for storing vDisks.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 85
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87. Scenario: Because the IT group needs to keep the amount of vDisk management and
storage requirements to a minimum, an administrator chooses to create a vDisk image
that can be used by multiple target devices at the same time. Which of the following
modes will the administrator select for the vDisk image?

a. Standard

b. NTFS

c. Mounted

d. Private
Answer: a.

Explanation: Standard Image mode allows multiple target devices to use a single vDisk at
the same time which greatly reduces the amount of vDisk management and storage
requirements.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 32

88. Scenario: The IT group needs a vDisk image on which the users will be able to install
their own applications and customize their desktops. The administrator that is put in
charge of creating this image should use _?_Image mode.

a. Standard

b. Private

c. NTFS

d. Mounted
Answer: b.

Explanation: Private Image mode allows users to install their own applications and
customize their desktops because read and write requests are allowed. Only one target
device at a time can access the contents of a vDisk when the vDisk is in Private Image
mode. All user data is automatically backed up to a server.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 34

89. Which of the following should an administrator keep in mind when creating a vDisk that
will be used in a target device that will utilize NIC teaming with its Intel dual-NIC setup?
a. The vDisk must be set to Private Image Mode
b. The vDisk must be set to Standard Image Mode
c. The target device software must be setup prior to configuring NIC teaming
d. NIC teaming only works with Provisioning Server 5.0
Answer: a.
Explanation: When an administrator is creating a vDisk that will be used in a target
device that will utilize NIC teaming, the administrator must set the vDisk to Private
Image Mode. NIC teaming must be set up prior to installing the target device software.
NIC teaming works with Provisioning Server 4.5 and later.
Source: Citrix Knowledge Center, Article CTX116356

#Managing Citrix Provisioning Server 5.0

90. To add a target device in the Provisioning Server Console, right-clicka _? and choose
Create Target Device.
a. Site
b. Server
c. Device collection
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d. Store
Answer: c.
Explanation: To create a target device in the Provisioning Server Console, right-click a
device collection and choose Create Target Device. Type the target device name.
Optionally, enter a description. Enter the MAC address. Optionally, select 'Apply the
collection template to this new device'. Click OK.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 174

To add a target device through the CLI, use the following command:
a. mcli add target device /r
b. mcli create target device /r
c. mcli create device /r
d. mcli add device /r
Answer: d.
Explanation: An administrator can create a target device using the CLI with the following
command: mcli add device /r
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 199

Target devices can be manually added to a device collection by importing the entries
from a(n) _?_file.

a. .MDB
b. .sQL
c. .CSV
d. .TXT
Answer: c.

Explanation: Target devices can be manually added to a device collection by being
imported from a .CSV file.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 126

In which three ways can target devices be manually added to a device collection?
(Choose 3)

a. Using the CLI

b. Importing from a .CSV file

c. Using the Stream Console

d. Using the Provisioning Server Console
Answer: a.b.d.
Explanation: Target devices can be manually added to a device collection using the mcli
command in the CLI, choosing Create Target Device in the Provisioning Server Console
or importing the entries from a .CSV file.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 125, 126

Which of the following are required to create a target device in the Provisioning Server
Console? (Choose 2)

a. Name

b. Description
c. Mac address
d. [P address
e. Atemplate
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Answer: a.c.

Explanation: To create a target device in the Provisioning Server Console, right-click a
device collection and choose Create Target Device. Type the target device name.
Optionally, enter a description. Enter the MAC address. Optionally, select 'Apply the
collection template to this new device'. Click OK.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 174

95. In order for target devices to be automatically added, an administrator must configure
settings at the following nodes in the console: (Choose 3)

a. Farm
b. Site
c. Store

d. Device Collection
Answer: a.b.d.
Explanation: In order for target devices to be automatically added, an administrator
must configure settings at the following nodes in the console: Farm - the auto-add
feature must be enabled in the Options tab of the Farm properties. Site - the auto-add
setting in the Options tab of the Site properties determines which device collection a
target device is added to. Device Collection - The template device setting in a device
collection determines which template device properties are applied to the new target
device when it joins the device collection.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 198

96. In order for target devices to be automatically added, an administrator must make the

following configurations in the console: (Choose 3)

a. Enable auto-add at the farm level

b. Choose the device collection at the site level

c. Choose the site at the store level

d. Choose the template device setting at the device collection level
Answer: a.b.d.
Explanation: In order for target devices to be automatically added, an administrator
must configure settings at the following nodes in the console: Farm - the auto-add
feature must be enabled in the Options tab of the Farm properties. Site - the auto-add
setting in the Options tab of the Site properties determines which device collection a
target device is added to. Device Collection - The template device setting in a device
collection determines which template device properties are applied to the new target
device when it joins the device collection.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 198

97. On a target device, verify the communications between it and the Provisioning Server
using the _?_.
a. Target Device Wizard
b. Image Builder utility
c. Virtual Disk Status screen
d. Provisioning Server Console
Answer: c.
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Explanation: An administrator can verify the communications between a target device
and Provisioning Server using the Virtual Disk Status screen. Double-click the vDisk
status icon in the target device system tray to launch the Virtual Disk Status screen.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 183

98. The _?_ automatically transfers the contents of the Master Target Device hard disk to a
vDisk file.
a. Target Device Wizard
b. Virtual Disk Status Screen
c. VHD Converter utility
d. Image Builder utility
Answer: d.
Explanation: The Image Builder utility transfers the contents of the Master Target Device
hard disk to a vDisk file.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 183

99. An administrator can take a look at the _?_inthe _? on a target device to verify
communications between the target device and Provisioning Server.
a. Virtual Disk Status screen / Start Menu
b. Target Device Status screen / Start Menu
c. target device statusicon / system tray
d. vDisk status icon / system tray
Answer: d.
Explanation: An administrator can verify communications between a target device and
Provisioning Server with the vDisk status icon in the target device system tray.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 183

100. Where can an administrator find out which vDisk a target device is connected to?
a. Status tab in Farm Properties
b. Status tab in Target Device Properties
c. Statusicon in the system tray
d. Status screen in Start Menu
Answer: b.
Explanation: To find out which vDisk a target device is connected to, double-click on the
target device in the Provisioning Server Console and click on the Status tab in Target
Device Properties.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 211

101. Where can an administrator restart all of the Provisioning Server services
automatically?
a. Server Properties in the Provisioning Server Console
b. Control Panel > Administrative Tools > Services
c. Configuration Wizard
d. Farm node in the Provisioning Server Console
Answer: c.
Explanation: An administrator can re-run the Configuration Wizard to restart all of the
Provisioning Server services.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 168
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102. Scenario: For security reasons, the port number of the License Server had to be
changed. For the Provisioning Servers to accept the port change, which Provisioning
Server service must be restarted on each server?

a. Stream

b. SOAP

c. STA

d. XML
Answer: a.

Explanation: Changing license properties requires that the Provisioning Server Stream
Service be restarted on each Provisioning Server for license changes to take effect.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 54

103. Scenario: An administrator made some needed changes to a Provisioning Server in the
server's properties, via the Console. After making the changes, which of the following
should the administrator do to allow the changes to take effect?

a. Reboot the Provisioning Server

b. Restart the Stream Service on the Provisioning Server

c. Restart the SOAP Service on the Provisioning Server

d. Inthe Console, right-click the server and choose 'Apply Changes to the Server'
Answer: b.
Explanation: After making changes to a Provisioning Server's properties, restart the
Stream Service to implement those changes.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 78

104. Scenario: The IP address of a Provisioning Server must to be changed in the server's
properties in the Console to reflect the actual static IP address of the server. After
changing the IP address in the properties, what must the administrator do to implement
the change?

a. Reboot the Provisioning Server

b. Restart the Stream Service on the Provisioning Server

c. Restart the SOAP Service on the Provisioning Server

d. Inthe Console, right-click the server and choose 'Apply Changes to the Server'
Answer: b.
Explanation: After making changes to a Provisioning Server's properties, restart the
Stream Service to implement those changes.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 78

105. The Stream Service runs under the _? _account.
a. Local Administrator
b. Domain Administrator

c. User
d. Guest
Answer: c.

Explanation: The Stream Service runs under the user account. When the Stream Service
accesses a vDisk stored locally on the Provisioning Server, the local user rights provide
full access. More rights are needed when the database or vDisk is located on a remote
storage device.
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Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 163

106. When configuring HA with shared storage, the Stream Service on all of the
Provisioning Servers that will participate in HA must use a _? account with rights to
both the Provisioning Server and the remote storage location.

a. local

b. database

c. root

d. domain
Answer: d.

Explanation: When configuring HA with shared storage, the Stream Service on all of the
Provisioning Servers that will participate in HA must use a domain account with rights to
both the Provisioning Server and the remote storage location.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 162

107. When using a Windows share for vDisk storage, the Stream Service account
credentials must be a _?_account.

a. domain

b. database

c. local

d. network
Answer: a.

Explanation: Stream Services run under a user account. If using a windows share to
store vDisks, the Stream Service account must run under a domain account,
configured on each Provisioning Server.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 162

108. What service account options are available to choose for the Stream Service and SOAP
Service? (Choose 3)

a. Database administrator account

b. Network Service account

c. Specified Windows user account

d. Local system account
Answer: b.c.d.
Explanation: The Stream and SOAP Services run under a user account specified in the
Configuration Wizard. The user account type will depend upon the type of shared
storage in use for vDisks and the database. The account options are Network Service,
specified user and local system.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 91

109. Which account should be configured for the Stream and SOAP Services if the network
environment supports minimal security?
a. Database administrator account
b. Network Service account
c. Specified Windows user account
d. Local system account
Answer: b.
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Explanation: The Network Service account has minimal privileges; therefore, the
account must be given explicit access to all local resources, including files, folders and
the registry. Choose this option if the environment supports this minimal security
option.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 91

110. To automatically assign sufficient access rights to the database, which option should

an administrator choose in the Configuration Wizard?

a. Datareader

b. Datawriter

c. Configure the database for the account

d. Configure the account for the database
Answer: c.
Explanation: When using a network or specified user account, administrators can
automatically assign sufficient access rights to the database for that device or user by
selecting 'Configure the database for the account' option in the Configuration Wizard.
Choosing this option will assign Datareader and Datawriter rights to the account.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 91, 92

111. Which of the following options can an administrator configure on the Server tab of the
Advanced Server Properties? (Choose 5)
a. Threads per port
Boot pause seconds
Buffers per thread
Maximum boot time
Server cache timeout
Maximum devices booting
Local concurrent 1/0 limits
vDisk creation pacing
i. Remote concurrent I/0O limits
Answer: a.c.e.g.i.
Explanation: On the Server tab of the Advanced Server Properties, an administrator can
configure 'Threads per port', '‘Buffers per thread', 'Server cache timeout', 'Local
concurrent I/0 limits' and 'Remote concurrent I/O limits'.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 73
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112. Which of the following options can an administrator configure on the Pacing tab of

the Advanced Server Properties? (Choose 4)
a. vDisk creation pacing

Threads per port

Server cache timeout

Buffers per thread

Maximum boot time

Maximum devices booting

Local concurrent 1/0 limits

Remote concurrent 1/O limits
i. Boot pause seconds

Answer: a.e.f.i.
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Explanation: On the Pacing tab of the Advanced Server Properties, an administrator can
configure 'vDisk creation pacing', 'Maximum boot time', 'Maximum devices booting' and
'‘Boot pause seconds'.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 74

113. Which of the following options can an administrator configure on the Network tab of

the Advanced Server Properties? (Choose 3)

a. Maximum transmission unit

b. 1/0 burst size

c. Local and remote concurrent I/O limits

d. Socket communications
Answer: a.b.d.
Explanation: On the Network tab of the Advanced Server Properties, an administrator
can configure 'Maximum transmission unit', 'l/O burst size' and 'Socket
communications'.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 74

114. An administrator can configure the amount of time of last hearing from a target

device before the target device's license is released in the _?_.

a. Pacing tab of Advanced Server Properties

b. Options tab of Server Properties

c. Network tab of Server Properties

d. Device tab of Advanced Server Properties
Answer: d.
Explanation: Configure the amount of time of last hearing from a target device before
the target device's license is released back into the license pool using the 'License
timeout' setting in the Device tab of Advanced Server Properties.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 74

115. The IP address and port number range that the Stream Service will use is configured in

the ? .

a. Network tab of Server Properties

b. Network tab of Advanced Server Properties

c. Device tab of Advanced Server Properties

d. Options tab of Server Properties
Answer: a.
Explanation: In the Network tab of Server Properties, enter the IP addresses that the
Stream Service should use for a target device to communicate with the Provisioning
Server. Also, enter the first and last UDP port numbers to indicate a range of ports to be
used by the Stream Service for target device communications.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 75

116. Enabling automatic password support for an Active Directory with Provisioning Server
environment is configured in the _? .
a. Network tab of Server Properties
b. Network tab of Advanced Server Properties
c. Device tab of Advanced Server Properties
d. Options tab of Server Properties
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Answer: d.
Explanation: Configure the Active Directory settings, 'Enable automatic password

support' and ‘Change computer account password every' in the Options tab of Server
Properties.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 76

117. Atleast _?_ ports must be configured in the Network tab of Server Properties for
Stream Service to target device communication.

a. 2
b. 5
c. 7
d 8
Answer: b.

Explanation: In the Network tab of Server Properties, enter the first and last UDP port
numbers to indicate a range of ports to be used by the Stream Service for target device
communications. The minimum number is five ports in a range.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 75

118. The default first port number for the Stream Service is _?_. The last port number is

2
a. 6910/6915
b. 6910/ 6960
c. 6910/6930
d. 6910/6990
Answer: c.

Explanation: In the Network tab of Server Properties, enter a minimum of five port

numbers in a range for the Stream Service. The default first port number is 6910 and the
last is 6930.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 75

119. vDisk properties are stored ina _?_file.

a. .VHD
b. boot
c. cache
d. .PVP
Answer: d.

Explanation: vDisk properties are stored in a .PVP file, while the contents of a vDisk are
stored in a .VHD file. When a vDisk is created, a .PVP file with the same name is
automatically created in the same storage location.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 252

120. When an administrator copies a vDisk to a new location, which of the following should
she be sure to also do?
a. Copy the .PVP file to the same directory as the vDisk
b. Rename the .VHD file to a .PVP file
c. Rename the vDisk on the Active Directory domain
d. Migrate the network settings to the new location
Answer: a.
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Explanation: .PVP and .VHD files must always reside in the same directory. If a vDisk is
copied or moved to a new location, the .PVP file must also be moved to the new
directory.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 252

121. Which of the following are suitable options to view vDisk properties using the

Console? (Choose 3)

a. Click the View menu and choose vDisk

b. Highlight a vDisk and select Properties from the Action menu

c. Right-click on a vDisk and select Properties

d. Double-click on a vDisk in the details pane
Answer: b.c.d.
Explanation: To view the properties of a vDisk using the Console, highlight a vDisk and
select Properties from the Action menu; right-click on a vDisk and select Properties; or
double-click on a vDisk in the details pane.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 86

122. Scenario: An administrator is trying to mount a vDisk as a drive letter but is unable to
because a lock exists on the vDisk. There are no target devices using the vDisk at this
time, so the administrator must manually release the vDisk. How can this be
accomplished?

a. Right-click the vDisk in the Console, choose Manage Locks, select the target

device in the list and click Remove Lock

b. Right-click the vDisk in the Console and select Remove Lock

c. Backup the vDisk, delete it from the console, recover it from backup

d. Clone the vDisk, delete the original and use the new
Answer: a.
Explanation: When a target device shuts down, the vDisk lock should automatically
release. If it does not then an administrator cannot perform some tasks on the vDisk
such as mounting it as a drive letter. To manually release the vDisk, the administrator
should right-click the vDisk in the Console, choose Manage Locks, which launches the
Manage vDisk Locks dialog, select the target device in the list and click Remove Lock.
Click Close on the Manage vDisk Locks dialog.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 250

123. In which scenarios might an administrator need to manually release a locked vDisk?

(Choose 3)

a. The target device is not shut down gracefully

b. The target device is gracefully shut down

c. The target device fails

d. Power to the target device is lost
Answer: a.c.d.
Explanation: Provisioning Server automatically releases vDisk locks when the target
device is gracefully shut down. An administrator might need to manually release a lock if
the target device is not shut down gracefully, if the target device fails or if power to the
target device is lost.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 249
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124. Which of the following steps are used to add an existing vDisk to the Console?

(Choose 2)

a. Right-click the vDisk Pool where you want to add the vDisks and select 'Add

existing vDisk'

b. Select the site where the vDisk will be added

c. Select the store that will be used to search for the vDisk

d. Select all of the target devices that use the vDisks
Answer: a.b.
Explanation: To add an existing vDisk to the Console, select the site where the vDisk will
be added, right-click the vDisk Pool in the site and select 'Add existing vDisk'.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 103, 104

125. Which of the following tasks should an administrator perform to add existing vDisks to
the Provisioning Server Console?

a. Select the device collection

b. Enable the search option in the site

c. Search the store

d. Import the .CSV file
Answer: c.
Explanation: To add existing vDisks to the Provisioning Server Console, right-click the
store to search and choose 'Add existing vDisk'. Select the site to which the vDisks will
be added. Select the server that will be used to perform the search. Click Search.
Select the desired vDisks. Click Add, OK and Close.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 245

126. An administrator can delete: (Choose 2)

a. avDisk file from a target device

b. avDisk entry from the database

c. both the vDisk entry from the database and the vDisk file from the store

d. avDisk name in vDisk properties
Answer: b.c.
Explanation: When a vDisk is deleted from the Console, the entry in the database is
removed but the vDisk file is not deleted. When a vDisk file is deleted, the entire
contents of the vDisk are deleted along with the vDisk entry in the database.
Source: CPV-200-1l Implementing Citrix Provisioning Server 5.0, Pages 247, 248

127. Which of the following steps are used to delete a vDisk file and database entry?

(Choose 3)

a. Right-click the vDisk and click Delete

b. Right-click the target device which is using the vDisk and click Delete vDisk

c. Choose to delete the associated VHD file

d. Verify the vDisk is not assigned to any target devices
Answer: a.c.d.
Explanation: To delete a vDisk file and database entry using the Console, first, verify that
the vDisk is not assigned to any target devices. If the vDisk is assigned to a target device,
unassign it before proceeding. Right-click the vDisk and click Delete. Select 'Delete the
associated VHD file(s)' and click Yes.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 248
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128. Scenario: The access mode of a vDisk needs to be changed from Standard Image to

Private Image. Where will the administrator make this change?

a. The General tab of vDisk File Properties

b. The Mode tab of vDisk File Properties

c. The Identification tab of vDisk File Properties

d. The Options tab of vDisk File Properties
Answer: b.
Explanation: On the Mode tab of vDisk File Properties, an administrator can configure
the vDisk for Private, Standard or RAM Disk imaging mode. Also, automatic updates,
cache size and cache type can be configured on the Mode tab.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 258, 259

129. Which of the following are on the Identification tab of vDisk File Properties? (Choose
3)
vDisk version number
vDisk serial number
vDisk model number
d. vDisk creation date
Answer: a.b.d.
Explanation: Among other fields, the Identification tab of the vDisk File Properties
dialog contains the vDisk version number, vDisk serial number and vDisk creation
date.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 259

o oo

130. Cache size and cache type for a vDisk can be configured where?
a. The General tab of vDisk File Properties
b. The Mode tab of vDisk File Properties
c. The Identification tab of vDisk File Properties
d. The Options tab of vDisk File Properties
Answer: b.
Explanation: Cache size and cache type can be configured on the Mode tab of vDisk
File Properties.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 258, 259

131. You can only configure the cache size if you choose _? for Access Mode and _?_for
Cache Type.
a. Private Image / Target device disk
b. Standard Image / Server disk
c. Standard Image / Target device RAM
d. Private Image / Target device RAM
Answer: c.
Explanation: The cache size in the vDisk File Properties, Mode tab, can only be
configured if Standard Image is chosen for Access Mode and target device RAM is
chosen for Cache Type.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 88
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132. Scenario: Automatic updates need to be scheduled for a vDisk. Where can an

administrator configure automatic updates for a vDisk?

a. The General tab of vDisk File Properties

b. The Mode tab of vDisk File Properties

c. The Identification tab of vDisk File Properties

d. The Options tab of vDisk File Properties
Answer: b.
Explanation: After enabling automatic disk updates in the Provisioning Server
Properties, an administrator can configure automatic updates on the Mode tab of the
vDisk File Properties. The administrator can choose between the options: 'Apply vDisk
updates as soon as they are detected by the server' and 'Schedule the next vDisk update
to occur on [specified time]'.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 259

133. Before configuring automatic vDisk updates in the vDisk File Properties, automatic
disk updates must be enabled _? .
a. inthe farm properties
b. inthe device collection properties
c. inthe server properties
d. inthe store properties
Answer: c.
Explanation: Configure the 'Enable automatic disk updates' options in the Options tab
of the Provisioning Server Properties before configuring automatic vDisk updates in
the vDisk File Properties.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 76

134. An administrator can enable which options on the Options tab of vDisk File

Properties? (Choose 3)

a. Printer management

b. Active Directory machine account password management

c. vDisk automatic updates

d. High availability (HA)
Answer: a.b.d.
Explanation: An administrator can enable or disable three options on the Options tab of
vDisk File Properties: 'High availability (HA)', 'Active Directory machine account
password management' and 'Printer management'.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 261

135. Scenario: The load balancing algorithm is currently being used to provide a vDisk to
target devices. An administrator needs to change the configuration to specify a specific
server from which to provide the vDisk to target devices. Where can the administrator
make this change?

a. The General tab of vDisk File Properties

b. The Mode tab of vDisk File Properties

c. The General tab of vDisk Properties

d. The Options tab of vDisk File Properties
Answer: c.
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Explanation: Either the load balancing algorithm or a specific server can be used to
provide a vDisk to target devices. This is configured in the General tab of vDisk
Properties. Don't confuse this tab with the General tab of vDisk FILE Properties.
Source: CPV-200-1I Iplementing Citrix Provisioning Server 5.0, Page 254

136. Scenario: An administrator needs to lock a vDisk and make it inaccessible to any target
device so that she can perform maintenance on the vDisk. She also needs to open the
advanced vDisk properties settings. Where can the administrator perform both of these
actions?

a. The Options tab of vDisk File Properties

b. The Mode tab of vDisk File Properties

c. The General tab of vDisk File Properties

d. The General tab of vDisk Properties
Answer: d.
Explanation: An administrator can select 'Allow use of this vDisk', which locks the vDisk
and makes it inaccessible to target devices, and 'Edit file properties', which opens the
vDisk File Properties dialog, which contains the advanced vDisk properties settings.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 254

137. Which of the following configurations can be accomplished on the Port Blocker tab of

vDisk Properties? (Choose 3)

a. Enable the Port Blocker feature for the vDisk

b. Display device categories that are either blocked or allowed on the vDisk

c. Add, edit or delete overrides for ports that access individual removable storage

media devices

d. Edit the port number range that Provisioning Server services will use
Answer: a.b.c.
Explanation: On the Port Blocker tab of vDisk Properties, an administrator can enable
the Port Blocker feature for the vDisk, display device categories that are either blocked
or allowed on the vDisk and add, edit or delete overrides for ports that access individual
removable storage media devices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 255

138. When Provisioning Server and Active Directory are integrated, how should an
administrator create a new target device in Active Directory using the Provisioning
Server Console?

a. Export computer accounts from Active Directory to Provisioning Server

b. Select 'Create machine account'

c. Choose 'Reset machine account' and 'Enable Active Directory machine account

password management'

d. Click the Add button on the General tab of the farm properties dialog
Answer: b.
Explanation: This action is usually handled in Active Directory Users and Computer, but
to take advantage of Provisioning Server, it must now be handled in the Provisioning
Server Console. To add a target device to Active Directory, right-click on the target deive
in the Provisioning Server Console, select Active Directory and select 'Create machine
account'. The Active Directory Management dialog launches. Select the target device
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from the list. Type the name of the Domain Controller, if desired. Type the Organization
Unit. Click 'Add devices'. Click Close.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 191

139. An administrator can remove a target device from an Active Directory domain by:
a. deleting the target device in the Provisioning Server Console
b. deleting the target device in Active Directory Users and Computers
c. removing the vDisk from the target device in the Provisioning Server Console
d. removing the license from the target device using the License Console
Answer: a.
Explanation: This action is usually handled in Active Directory Users and Computer, but
to take advantage of Provisioning Server, it must now be handled in the Provisioning
Server Console. To remove a target device from Active Directory, right-click on the
target device in the Console, select Active Directory Management and select 'Delete
machine account'. The Active Directory Management dialog will launch. In the Target
Device table, highlight the target device and click Delete Devices. Click Close.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 191

140. Which task should a farm administrator perform to allow a site administrator to
manage a store?
a. Assign the site as the owner of the store in the Store Properties dialog
b. Assign the site as the owner of the store in the Site Properties dialog
c. Move the Site node to the Store node in the Console
d. Move the site administrator to the Store node in the Console
Answer: a.
Explanation: To allow a site administrator manage a store, a farm administrator can
assign the site of the site administrator as the owner of the store in the Store
Properties dialog.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 61, 66

#Maintaining Citrix Provisioning Server 5.0

141. When HA is set up, a minimum of _?_login Provisioning Servers must be listed in the

boot file.
a. four
b. two
c. three
d. one
Answer: b.

Explanation: When HA is set up, a minimum of two login Provisioning Server must be
listed in the boot file. A maximum of four servers can be listed.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 157

142. A maximum of _?_servers can be listed in the boot file for use with high availability.

a. one
b. two
c. three
d. four
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Answer: d.

Explanation: Using HA, a maximum of four Provisioning Servers can be listed in the boot
file.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 157

143. Provisioning Servers can be configured as login servers usingthe _? orthe ? .

(Choose 2)

a. Advanced Server Properties

b. CLI

c. Configure Bootstrap dialog

d. Configuration Wizard
Answer: c.d.
Explanation: Provisioning Servers can be configured as login servers using the
Configuration Bootstrap dialog in the Console or the Configuration Wizard.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 157, 158

144. Which of the following configurations must be made for an HA implementation?
(Choose 5)
a. Setup a Proxy DHCP server that hosts the PXE Service
b. Add at least two Provisioning Servers to the Stream Service list in the bootstrap
file
Ensure the Stream Service is properly configured
Ensure the write cache is properly configured
Enable the HA option on the vDisk
f. Enable load balancing on the vDisk
Answer: b.c.d.e.f.
Explanation: To implement an HA environment, add at least two Provisioning Servers to
the Stream Service list in the bootstrap file, ensure the Stream Service is properly
configured, ensure the write cache is properly configured, enable the HA option on the
vDisk and enable load balancing on the vDisk.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 318

® a0

145. Which of the following tasks are involved in manually configuring the bootstrap file?

(Choose 4)

a. Add the IP address of the server that will act as a login server

b. Add the port number for the Stream Service

c. Configure the netmask and gateway settings

d. Select the load balancing method

e. Choose the network recovery method
Answer: a.b.c.e.
Explanation: To manually configure a bootstrap file, right-click the server that acts as the
TFTP server and click Configure Bootstrap. Click Add and type the IP address of the
Provisioning Server that will act as a login server. Type the port number that is
configured for the Stream Service. Configure the netmask and gateway settings by
either choosing to use the supplied settings or typing the information in the fields and
click OK. Click Move Up or Move Down to place the Provisioning Servers in the order in
which target devices should contact for login processing. Click the Options tab and
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select the network recovery method. Optionally, make any additional configuration
changes. Click OK to close the Configure Bootstrap screen.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 319, 320

146. Which of the following pieces of information must be entered to in the bootstrap file
to identify the log in server?
a. MAC address
b. hostname
c. IPaddress
d. FQDN
Answer: c.
Explanation: Add the IP address of the Provisioning Server that will act as a login server
to the bootstrap file.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 319

147. To manually configure a bootstrap file, right-click the server that acts as the _?_server
and click Configure Bootstrap.

a. PXE
b. DHCP
c. TFTP
d. Proxy
Answer: c.

Explanation: To manually configure a bootstrap file, right-click the server that acts as the
TFTP server and click Configure Bootstrap. Click Add and type the IP address of the
Provisioning Server that will act as a login server. Type the port number that is
configured for the Stream Service. Configure the netmask and gateway settings by
either choosing to use the supplied settings or typing the information in the fields and
click OK. Click Move Up or Move Down to place the Provisioning Servers in the order in
which target devices should contact for login processing. Click the Options tab and
select the network recovery method. Optionally, make any additional configuration
changes. Click OK to close the Configure Bootstrap screen.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 319, 320

148. Scenario: An administrator is configuring HA for the Provisioning Server environment.
The wrong service account credentials were entered for the Stream Service in the
Configuration Wizard, so the administrator must manually change the credentials.
Where should the administrator go to manually configure the service account
credentials for the Stream Service?

a. The .VHD file

b. Provisioning Server Advanced Properties

c. The bootstrap file

d. Control Panel > Administrative Tools > Services
Answer: d.
Explanation: To manually assign the service account credentials to the Stream Service,
open the Control Panel and go to Administrative Tools > Services. Double-click on the
first PVS Stream Service name in the Services list. On the Log On tab, select This Account
and click Browse. Click Locations, select the domain node and click OK. Type the name
of the Stream Service user account and click Check Names. Click OK to close the Select
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User dialog. On the Log On tab, enter and confirm the Stream Service account password,
confirm the password and click OK. Restart the Stream Service.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 164

149. When configuring HA for a Provisioning Server environment, administrators must plan
for the placement of the write cache. Where can the write cache be placed? (Choose 4)
a. Provisioning Server RAM
b. Provisioning Server disk
c. Shared storage
d. Target device disk
e. Target device RAM
Answer: b.c.d.e.
Explanation: When configuring HA for a Provisioning Server environment, administrators
can choose among a Provisioning Server disk, shared storage, target device disk or
target device RAM to place the write cache. If the Provisioning Server disk crashes, a
write cache would be lost. To prevent this from happening, the write cache should be
stored in shared storage or on the target device.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 320

150. Itis recommended that a shared storage location is used for a _?_cache.
a. target device-based RAM
b. target device-based disk
c. server-based disk
d. network-based
Answer: c.
Explanation: It is recommended that administrators place server-based disk caches in
a shared storage location. Doing so ensures that, when using HA, the write cache is
maintained along with the target device connection.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 155

151. Which write cache provides the fastest method of disk access?
a. Provisioning Server disk
b. Shared storage
c. Target device disk
d. Target device RAM
Answer: d.
Explanation: Target device RAM cache provides the fastest method of disk access.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 156

152. Of the following, which write cache method would an administrator want to stay away
from if he were concerned with both disk I/O and network traffic?
a. Target device-based disk cache
b. Server-based disk cache
c. Target-device-based RAM cache
d. Server-based RAM cache
Answer: b.
Explanation: Using server-based disk cache, Provisioning Server handles all writes,
which can increase both disk I/0 and network traffic. If an administrator is concerned
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about either or both of these resources, he should probably use a different write
cache method.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 155

153. What are the prerequisites that need to be met prior to integrating Provisioning

Server with Active Directory? (Choose 2)

a. The Disable Machine Account Password Changes option was selected in the

Image Optimization Wizard

b. The Master Target Device was added to the domain after building the vDisk

c. HA was configured in the Provisioning Server environment

d. The Stream Service was stopped on all Provisioning Servers in the environment
Answer: a.b.
Explanation: Prior to integrating Provisioning Server with Active Directory, the Disable
Machine Account Password Changes option must have been selected in the Image
Optimization Wizard and the Master Target Device must have been added to the
domain AFTER building the vDisk.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 187

154. Scenario: An administrator is integrating Provisioning Server with Active Directory and
adding multiple target devices which share the same vDisk. Which of the following are
some of the steps the administrator will take to accomplish this task? (Choose 4)

a. Verify the vDisk is in Private Image mode

b. Enable HA in vDisk File Properties

c. Enable 'Active Directory machine account password management' in vDisk

Properties
d. Enable 'Automatic password support' in Server Properties
e. Run the Image Optimization Wizard and verify that Disable Machine Account
Password Changes is selected

Answer: a.c.d.e.
Explanation: To integrate Provisioning Server with Active Directory when adding
multiple target devices which share the same vDisk: Verify the vDisk is in Private Image
mode and assign the vDisk to the target device. Set the target device to boot from the
hard disk. Enable 'Active Directory machine account password management' in vDisk
Properties. Enable 'Automatic password support' in Server Properties. Create the clean,
golden image on the Master Target Device hard drive. Update the golden image with
necessary patches or drivers. Add the Master Target Device to the domain. Install the
target device software. Reboot the target device and configure the BIOS to PXE boot.
Run the Image Optimization Wizard and verify that Disable Machine Account Password
Changes is selected. Build the image to the vDisk file and shutdown the target device.
Change the vDisk file to Standard Image mode. Configure a new target device and assign
the vDisk. Create a machine account for the new target device using the Console or the
Run AddDeviceToDomain command. Boot the new target device from the vDisk and log
on to the domain.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Pages 221, 222

155. When significant changes will be made to the vDisk, _? updates are typically used.

a. automatic
b. incremental
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c. differential

d. manual
Answer: a.
Explanation: When significant changes will be made to the vDisk, automatic updates are
typically used. Automatic updates replace the mapping of a vDisk in the database with a
new, updated version of the vDisk file.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 265

156. Which two of the following options are required to successfully perform automatic
vDisk updates? (Choose 2)
a. Create a new .PVP file with the identical name as the original .PVP file
b. The Class fields of the original vDisk and updated vDisk must be the same
c. The version number of the updated vDisk must be greater that the version
number of the original vDisk
d. Setthe access mode to Private
Answer: b.c.
Explanation: To successfully perform automatic vDisk updates, be sure the Class fields
of the original and updated vDisks are the same and verify that the version number of
the updated vDisk is greater than the version number of the original vDisk.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 266

157. Scenario: An administrator needs to add a new service pack and all of the security
updates from the past couple of months to the operating system on a vDisk. Which of
the following options should the administrator use to update the vDisk?

a. incremental update

b. automatic update

c. Autoupdate tool

d. roll back
Answer: b.
Explanation: When significant changes will be made to the vDisk, automatic updates are
typically used. In this case, installing a service pack and several security updates would
qualify as a significant update.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 265

158. When minor changes will be made to the vDisk or if bandwidth usage is a concern, ?_

updates are typically used.

a. automatic

b. incremental

c. differential

d. manual
Answer: b.
Explanation: When minor changes will be made to the vDisk or if bandwidth usage is a
concern, incremental updates are typically used. Incremental updates apply a delta file
to the vDisk.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 265

159. _? are created to make managing target devices easier by organizing them into
groups according to physical location, business unit or user type, for example.
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a. Device collections
b. Sites
c. Views
d. Stores
Answer: c.

Explanation: Target device views are created to make managing target devices easier by
organizing them into groups according to physical location, business unit or user type,
for example.

Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 203

160. Scenario: A vDisk image used by the accounting department was recently updated
with an application patch. In order for the update to take effect, all of the accounting
department's target devices need to be restarted. The accounting department is in the
same device collection as everyone else in the corporate office. How should the
administrator go about restarting only the accounting department's target devices?

a. Walk to each target device and manually restart them
b. Inform each accounting department user to restart their target device at the
end of the day
c. Create an Active Directory Group Policy to reboot the target devices in the
accounting department's Organizational Unit
d. Create a view which only contains the accounting department's target devices
and reboot the target devices in the view
Answer: d.
Explanation: When tasks are performed on a view, the task is performed on all of the
members of the view. The tasks that can be performed in a view are: Pasting device
properties, booting or rebooting target devices, shutting down target devices and
sending a message to target devices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 203

161. Which of the following tasks can be performed to the target devices in a view?
(Choose 4)
Pasting device properties
Booting or rebooting target devices
Remotely controlling target devices
Shutting down target devices
e. Sending a message to target devices
Answer: a.b.d.e.
Explanation: When tasks are performed on a view, the task is performed on all of the
members of the view. The tasks that can be performed in a view are: Pasting device
properties, booting or rebooting target devices, shutting down target devices and
sending a message to target devices.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 203

oo oo

162. After integrating Active Directory and Provisioning Server, an administrator should
complete which of the following tasks to be sure that users are able to log on to the
domain from their target devices?

a. Enable Active Directory machine account password management
b. Allow Provisioning Server to extend the Active Directory schema
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c. Lengthen the time of the Login General Timeout setting

d. Add all target device users to the Domain Admin group in Active Directory
Answer: a.
Explanation: After integrating Active Directory with Provisioning Server, each target
device that logs on to the domain requires a computer account on the domain
controller. The password for the account is stored on both the domain controller and
the target device. If the passwords do not match, the user will not be able to log on to
the domain. To fix this, in the vDisk File Properties on the Options tab, select 'Enable
Active Directory machine account password management'.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 189

163. After Active Directory and Provisioning Server integration, to allow Provisioning Server
to manage domain passwords for target devices which share a vDisk, which security
policy must be enabled?

a. Enable Active Directory machine account password management

b. Disable machine account password changes

c. Enable automatic password support

d. Change private key password
Answer: b.
Explanation: After Active Directory and Provisioning Server integration, to allow
Provisioning Server to manage domain passwords for target devices which share a vDisk,
enable the 'Disable machine account password changes' security policy either at the
domain or target device level.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 188

164. When integrating Active Directory and Provisioning Server, a machine account can be
created for each target device only if the following prerequisite was fulfilled: (Choose 2)
a. 'Disable machine account password changes' is enabled
b. 'Enable Active Directory machine account password management' is selected
c. The Master Target Device was added to the domain after building the vDisk
d. Automatic password support is enabled
Answer: a.c.
Explanation: When integrating Active Directory and Provisioning Server, a machine
account can be created for each target device only after 'Disable machine account
password changes' is enabled and the Master Target Device was added to the domain
after building the vDisk.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 187

165. Which of the following options are correct when quickly copying the properties of one

target device in a view to all of the other target devices in the view: (Choose 3)

a. Right-click the view and select 'Copy device properties'

b. Select the desired properties and click Copy

c. Right-click the view and select 'Paste device properties'

d. Select the desired target devices and select Paste
Answer: b.c.d.
Explanation: To quickly copy the properties of one target device in a view to all of the
other target devices in the view, right-click the target device and select 'Copy device
properties'. Select the desired properties in the Copy Properties dialog box and click
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Copy. Right-click the view and select 'Paste device properties'. Select the desired target
devices and select Paste.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 151

#Troubleshooting Citrix Provisioning Server 5.0

166. The three logging levels that can be set using stream_log.config are: (Choose 3)

a. Log

b. Error

c. Debug
d. Trace

Answer: b.c.d.

Explanation: Provisioning Server logging can be set in the stream_log.config file. The
three logging levels are Error, Debug and Trace.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 126, 127

167. On which of the following Provisioning Server utilities can logging be enabled and the
logging level set?
a. MCLI
b. Configuration Wizard
c. Stream Console
d. Boot Device Manager
Answer: c.
Explanation: Provisioning Server logging can be enabled and the logging level set using
the Stream Console. The logging level can be set at Error, Debug or Trace.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 216

168. Scenario: Users in a Provisioning Server 5.0 environment report that they are able to
login to their target devices, but that they automatically shut down within 5 minutes.
The administrator checks the Provisioning Server and receives a message about not
being able to contact the License Server. Where should an administrator look for more
information about the licensing message?

a. License Management Console
b. License Server log files
c. Provisioning Server log files
d. Event Viewer
Answer: d.
Explanation: To resolve any Citrix licensing issues, an administrator should check Event
Viewer for more information about any messages that are received.
Source: Citrix Knowledge Center, CTX106250 and CTX117793

169. Scenario: A target device is unable to connect to a vDisk and the administrator
receives a message warning that the vDisk is locked. Which of the following is the most
likely cause?

a. The vDisk needs to be dismounted

b. The vDisk needs to be changed from Private Image mode to Standard Image
mode

c. The vDisk file is corrupt
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d. The vDisk needs to be formatted
Answer: a.
Explanation: A target device cannot connect to a vDisk while it is mounted.
Source: CPV-200-1I Implementing Citrix Provisioning Server 5.0, Page 160

170. The three logging levels that can be set on the Stream Console are: (Choose 3)

a. Trace

b. Debug
c. Error

d. Warning

Answer: a.b.c.

Explanation: Logging can be enabled for the Stream Console and the logging level can be
set to: Level 1 - Error; Level 2 - Debug; or Level 3 - Trace. This can also be configured in
stream_log.config.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 214, 215

171. To set the Stream Console to log errors only, which level should an administrator set?

a. Levell
b. Level 2
c. Level3
d. Level4d
Answer: a.

Explanation: Logging can be enabled for the Stream Console and the logging level can be
set to: Level 1 - Error; Level 2 - Debug; or Level 3 - Trace. This can also be configured in
stream_log.config.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 214, 215

172. Which of the following tasks will allow debug logging for a Provisioning Server to be
recorded on a log file?
a. Enter "DEBUG" as the 'level value' in the stream_log.config file
b. Enter "2" as the 'level value' in the stream_log.config file
c. Setthe logging level to 2 in the Provisioning Server Console
d. Runthe command: MCLI set log level value = debug
Answer: a.
Explanation: Provisioning Server logging can be configured in the stream_log.config
file. Set the logging 'level value' to the desired level. The levels are ERROR, DEBUG and
TRACE.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 214, 215

173. In which two places can an administrator enable logging for Provisioning Server?
(Choose 2)
a. Provisioning Server Console
b. Stream Console
c. stream.log
d. stream_log.config
Answer: b.d.
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Explanation: Logging can be enabled and set on the Stream Console or in the
stream_log.config file with the using the "level value". The logs get written to the
stream.log file.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 214, 215

174. To keep target devices from releasing their licenses prematurely because of downtime

or network latency, which of the following should an administrator configure?

a. Maximum boot time

b. License timeout

c. Maximum transmission unit

d. Server cache timeout
Answer: b.
Explanation: Configure the amount of time of last hearing from a target device before
the target device's license is released back into the license pool using the 'License
timeout' setting in the Device tab of Advanced Server Properties.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 74

175. When starting a target device, if an error appears stating that no virtual disk is
assigned, where can an administrator resolve this issue?
a. server properties
b. farm properties
c. target device properties
d. vDisk properties
Answer: c.
Explanation: To assign a vDisk to a target device, select the vDisk(s) to make available
to this target device on the vDisks tab of the Target Device Properties dialog box.
Configure the boot options and click OK.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 95

176. Scenario: Active Directory was recently integrated with a Provisioning Server 5.0
environment. An administrator created a vDisk with a Master Target Device that is not a
member of Active Directory. The administrator selected the Optimize option when
building the vDisk image. 8 target devices will access the vDisk. Machine account
password management was enabled in the vDisk properties and automatic password
management was enabled in the server properties. The 8 target device machine
accounts were created in Active Directory. The vDisk was streamed to the target
devices. The administrator attempted to log on to the domain, but none of the target
devices could log on. Which of the following tasks must the administrator perform to
allow the 8 target devices to log on to the domain? (Choose 2)

a. Undo the Optimize option when building the vDisk image

b. Select Standard Image mode for the vDisk

c. Build a new vDisk image

d. Add the Master Target Device to the domain
Answer: b.d.
Explanation: In an Active Directory integrated Provisioning Server environment, to
create multiple target devices that will all access the same vDisk and be managed by
Provisioning Server: Create the vDisk using the Master Target Device and then add the
Master Target Device to Active Directory. By selecting the Optimize option while
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building the vDisk image, the 'Disable machine account password changes' security
policy is enabled at the local level and is applied to all target devices that boot from
the vDisk image. Enable machine account password management and Standard Image
mode (to allow multiple target devices to use this one vDisk) in the vDisk properties
and automatic password management in the server properties. Create the target
device machine accounts in Active Directory using the Provisioning Server Console.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 187 - 192

177. Scenario: After creating a vDisk and assigning it to a target device, the target device is
rebooted and the BIOS is configured to boot to PXE. The target device attempts to boot
but a boot loader error appears instead of Windows. Which of the following probably
caused the error?

a. The wrong password was entered in the Authentication field in the Target
Device Properties
b. High availability and load balancing have not been configured yet
The write cache is stored on the server disk instead of the target device disk
d. The wrong vDisk was chosen in the 'Select vDisks for this device' field in the
Target Device Properties

Answer: d.

Explanation: When configuring a target device to boot to a vDisk, the administrator

must be sure to choose a vDisk that contains a valid image in the 'Select vDisks for this

device' field in the target device's properties or an error will appear when attempting
to boot the target device.

Source: Citrix Provisioning Server 5.0 Administrator's Guide, Page 95

o

178. Scenario: In an Active Directory with Provisioning Server 5.0 environment, an
administrator created a vDisk with a Master Target Device. The Master Target Device
was added to Active Directory after creating the vDisk. Machine account password
management was enabled in the vDisk properties and automatic password management
was enabled in the server properties. The vDisk was streamed to a target device. The
administrator attempted to log on to the domain, but could not log on. Which of the
following tasks must the administrator perform to allow the target device to log on to
the domain?

a. Select the Optimize option when building the vDisk image

b. Add the target device machine accounts to Active Directory

c. Select Standard Image mode for the vDisk

d. Build a new vDisk image
Answer: b.
Explanation: In an Active Directory integrated Provisioning Server environment, to
create a target device that will access a vDisk and be managed by Provisioning Server:
Create the vDisk using the Master Target Device and then add the Master Target
Device to Active Directory. Enable machine account password management in the
vDisk properties and automatic password management in the server properties.
Create the target device machine account in Active Directory using the Provisioning
Server Console.
Source: Citrix Provisioning Server 5.0 Administrator's Guide, Pages 187 - 192
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